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PC LITERACY II 
TOPICS COVERED IN THIS CLASS 

• Common Window Elements 

• Multitasking 

• Working with Files and Folders 

• Toolbars, Ribbons, and Commands 

• Using Copy & Paste 

• Printing 

COMMON WINDOW ELEMENTS 
Most windows have common features, so once you become familiar with 

one program, you can use that knowledge in another program. To begin, 

double-click the Internet Explorer icon on the desktop to start the web 

browser (other web browsers include Google Chrome, Mozilla Firefox, and 

more). Next, click the Start Button and click Calculator to open the program. 

Locate the following items in the Internet Explorer or Calculator window: 

• Maximize/Restore Button—the center button of the three buttons in the top 

right of a window used to resize a program window. Maximize the window to 

make it full screen size, or Restore Down to reduce the size of the window. 

 

•  Minimize Button—the left button of the three buttons in the top right of a 

window used to minimize a program window. A minimized window remains 

open, but is visible only as an icon on the taskbar. 

 

• Close Button—the right button of the three buttons in the top right of a window used to quit a 

program or close a document window. 

 

• Title Bar—the bar across the top of the window which, in many programs, will display the name 

of the program. 

 

•  Scroll Bar—the vertical/horizontal bar at the right/bottom of a window. Use the scroll bars to 

view the contents of a window that are not shown. If the entire contents are displayed, there will 

be no scroll bars.  
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• Address Bar—the text box in a web browser or Windows 

explorer window displaying the address of the page or 

location of the folder that is currently being viewed. 

 

• Menu Bar—the row of menus near the top of a window. 

Menus are drop-downs used to access the tools and options available in many programs. 

 

• Tab(s)—an element that allows you to navigate between 

multiple pages, documents, or views within one window. For 

example, you can have more than one web page open 

within one browser window, and use the tabs to select the page you want to display. 

MULTITASKING 
You can have two or more programs open at the same time and switch between the open programs. For 

example, you may want to send an email with information that you found on the Internet, or have typed 

in a Word document. Or, you may want to take notes in Word on a topic you are researching on the 

Internet. 

1. If necessary, use the Restore Down button to reduce the size of the Internet Explorer window. 

2. Next, use the Minimize button to hide the program on the taskbar. 

3. Double-click the Microsoft Word icon on the desktop to open the program.  

You now see the Word icon and the Internet Explorer icon on the taskbar as well as the Start button 

and a few pinned programs. Pinned programs are always on the taskbar but may not be open. Open 

programs have a box around them. Minimized programs (in this case, Internet Explorer) have slightly 

darker shading while visible programs (in this case, Word) are slightly brighter. 

  
4. Use the Restore Down button to reduce the size of the Microsoft Word window. 

5. Click the Internet Explorer icon on the taskbar to view the program.  

6. Click and hold on the title bar on either window to drag and drop the window to a different place on 

your screen.  

For example, you may want to move them so they are side by side so that you can see the contents of 

both windows at once. You can also minimize, maximize/restore, or close either of the windows at any 

time or use Windows keyboard shortcuts ( +T or +Tab) to cycle through open programs. 

7. Click the X to close the Internet Explorer Window. 

WORKING WITH FILES AND FOLDERS 
Most programs allow you to save your work to continue or modify later without having to recreate it or 

start all over again. The steps for creating and saving a file will be similar in most programs to the steps 

we will practice in Microsoft Word. For example, you can save a picture in a photo editing program or a 

spreadsheet in Excel using the same (or similar) steps. 
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CREATING AND SAVING A FILE 

1. In your open Word document, type your name at the 

Insertion Point (the blinking cursor).  

2. Press Enter to move the Insertion Point to the next line. 

3. Type the city and state you live in.  

4. Click the File Tab near the 

top left of the screen to 

display the file menu 

options.  

5. Click Save As from the menu options.  

6. Click the Desktop folder from the Recent Places list on 

the right. The Save As dialog box opens and Word 

automatically suggest the first line of the document as 

the title in the File Name box.  

7. Click Save to save the document to the desktop with 

your name as the file name. 

8. Click the X to close Microsoft Word.  

FILE MANAGEMENT 

On your home computer, save documents to the My Documents folder (which you 

do not have access to here at the library). Use a file management system of 

properly labeled folders and specifically named files to make all your work easy to 

find. For example, make a folder called “2017 Budgets” which would have your 

budget spreadsheet files “January2017Budget”, “February2017Budget”, and so 

on. (More on folders later.) 
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NAMING FILES 

Most Windows files have names with two parts separated by a period. For example: 

January2017Budget.xlsx The first part of the filename is assigned by the creator (you or the originator of 

the file or program). The second part is known as the “file extension” which indicates to Windows what 

type of file it is and how to process/open it.  

Each file also has an address or “path” indicating its location on the computer. For example: 

C:\Budgets\2017 Budgets\January2017Budget.xlsx Read backwards, this “January2017Budget” file is an 

Excel spreadsheet (.xlsx) in the 2017 Budgets subfolder in the Budgets folder located on the C: Drive. 

OPENING A FILE 

Now that you have created and saved a file, you can return to it to edit, add to, or even print your 

document.  

1. Open Microsoft Word by double-clicking the icon on the desktop OR by clicking the Start Button and 

clicking Microsoft Word from the programs list.  

2. Click the File tab and click Open from the menu options. Click Browse to display the Open dialog box.  

 

3. Navigate to the file location by clicking Desktop in the left pane. Locate and click on the file (with your 

name as the file name and a Word logo) from the list on the right. 

 

4. Click Open to open the file.  

 

5. In your document, click to the end of the line with your city and state and press Enter to move the 

insertion point to the next line. Then, type today’s date.  
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6. Click the X to close Microsoft Word. Word recognizes that you did not save the last change you made 

to the document and prompts you asking, “Do you want to save the changes to your document?” 

 

7. Click Yes to save your changes and close the program. 

CREATING A FOLDER 

As previously mentioned, you can use folders to organize your 

files. You can create a folder on the desktop and then move 

existing files, or save future files in that folder. You can also 

create a folder within a folder (known as a subfolder). Example: 

Budgets folder\2017 Budgets subfolder\January 2017 Budget 

spreadsheet. 

1. Right-click on the Desktop and click New>Folder from the 

shortcut menu. A new folder appears. 

2. Type My Work and press Enter to give the folder a name. 

3. To move the document you saved earlier into the folder: 

a. Find the file on your desktop (your name is the filename). 

b. Click on the file and hold to “pick it up”, then drag it until it is on top of 

the My Work folder (You will see a Move to My Work screen tip appear). 

c. Let go of the mouse to “drop” the file into the folder. 

4. Double-click to view the contents of the folder in Windows Explorer.  

 

Windows Explorer allows you to navigate 

through files, folders, and programs on 

your computer. The file you moved is now 

inside the folder. You can save any future 

documents to this location and create new 

folders and subfolders to begin a file 

management system.  

TOOLBARS, RIBBONS, AND COMMANDS 

TOOLBARS 

Toolbars are the areas across the top of a program, that contain Buttons, 

Menus, Icons, or other input/output elements. Many programs have 

toolbars which can be customized and/or hidden. For example, if you 

right-click on the Internet Explorer toolbar you will see options to 

show/hide different toolbars as well as other toolbar options (shown 

right). Some common toolbars include the Menu Bar, a Favorites or 

Bookmarks Bar (in a web browser), and the Command Bar.   
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THE MENU BAR 

The Menu Bar is the toolbar with drop down menus. Though the menus are program specific, typical 

menu bars include File, Edit, View, and Help, as well as a Favorites or Bookmarks menu in web browsers. 

 

• The File Menu contains options such as New, Open, Close, Save, Print, Properties, and Exit. 

• The Edit Menu contains options to Copy, Paste, Select, and Find content on a page. 

• The View Menu contains options for modifying the appearance of the window such as turning 

on/off toolbars, changing the zoom, arranging icons, or applying full screen or other special views. 

RIBBONS IN MICROSOFT OFFICE 

In Office versions 2007 and forward, Microsoft replaced menu drop-downs with “ribbons” which allow 

you to click on a tab to display a ribbon of command buttons. The ribbon stays visible (as opposed to a 

drop-down menu that goes away once a command is selected) at the top of the screen with the most used 

commands in each group.  

Each tab in Microsoft Office displays the corresponding ribbon, except the File tab which displays the 

“Backstage View” with common file menu options. Each ribbon is divided into groups (separated by a 

vertical line) and each group consists of buttons, drop-down menus, and galleries. Roll over a button to 

view a screen tip with a description of what the button does.  

TIPS FOR EXECUTING COMMANDS 

There is usually more than one way to execute a command on the computer. For example, you can copy 

a selection by selecting Copy from the Edit Menu, OR using the keyboard shortcut Ctrl+C, OR right-clicking 

to select Copy from the Shortcut Menu. (More on copying next.) Use the way that works best for you.  

It is also important to remember that you will not “break” the computer by experimenting or trying to 

remember how to perform a task. In many programs, you can also “undo” an action if you make a mistake 

by using the undo button, OR the keyboard shortcut Ctrl+Z. 
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USING COPY & PASTE 
As previously mentioned you can multitask by working in two or more programs at a time. You can also 

transfer information from one program to another (or from one location to another in a single program) 

using Copy & Paste. You can copy a selection of text, an image, or an entire file and then paste it in another 

location. For example, you can copy a file from one folder to another, or you can copy text from a website 

into a Word document.  

1. Double-click the Internet Explorer icon to open the program and type 

www.wikipedia.org in the address bar. 

A “wiki” is a website in which all the users can contribute information. 

Therefore, Wikipedia is an encyclopedia where users 

can add information about any topic. You can use 

Wikipedia to learn more about a topic because, 

although user-generated, the content is monitored 

and generally accurate. 

 

2. Type in a topic you would like to learn more about in 

the search bar and press Enter.  

Note: If your search requires clarification, you may 

have to click to choose from a list of topics.  

For example: Play (activity) vs. Play (theatre) 

 

3. To select the first paragraph: 

a. Place your I beam pointer before the first 

letter of the first word of the article.  

b. Click and hold and drag the mouse down and to the right until you reach the end of the last 

sentence of the first paragraph. 

c. Let go of the mouse and your paragraph will be selected (indicated by white text with a 

colored background background). 

  

http://www.wikipedia.org/
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4. To copy the selection, use one of the following methods: 

 

a. Click Edit on the menu bar and select Copy, OR 

b. Right-click on the selected paragraph and select Copy from the 

shortcut menu, OR 

c. Hold Ctrl on your keyboard and press C. 

 

Your selection is now saved temporarily to the computer’s memory.  

 

5. Minimize Internet Explorer and double-click on the Microsoft Word icon on the desktop to open the 

program. 

 

6. To paste the selection, use one of the following methods:  

 

a. Click Paste in the Clipboard group on the Home tab, OR 

b. Right-click in the document area and select the first paste option icon 

from the shortcut menu, OR 

c. Hold Ctrl on your keyboard and press V. 

AVOIDING COPYRIGHT ISSUES 

Copying and pasting content from the Internet for personal use is usually acceptable. The Fair Use 

Exception also allows individuals limited use of copyrighted material for commentary, criticism, satire, 

education or research. However, copyrighted content may not be published anywhere else (or used to 

make money) without the permission of the author. You must also give credit to the author to avoid 

copyright infringement.  

PRINTING 
Printing allows you to produce a hard copy of a digital file. In order 

to print you will need a printer connected to your computer. 

Printers vary in size, speed, sophistication, and cost. The four 

printer qualities of most interested to users are: 

• Color (can be color or black & white printer) 

• Resolution (sharpness of text and images) 

• Speed (inexpensive printers print about 3-6 sheets per minute) 

• Memory (more memory increases the speed of pages with 

complex graphics) 
 

1. To print, go the File Menu and select Print (or hold Ctrl on your keyboard and press P). 

2. Select from settings such as which pages to print, number of copies, layout, one or two sided, and 

more (options will vary based on the program and the connected printer’s capabilities). 

3. Click Print after selecting your settings to print the page(s).  
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